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要   旨 

 東日本大震災からの復旧のため進められている海岸防災林整備では、造成した生育基盤

にマツ類を主林木とした植栽が行われており、一部で植栽木の枯死や生育不良が確認され

た。そこで、枯死、生育不良の原因及び対策方法について調査した。また、広大な造成地で

植栽木の生育状況を把握する簡易な手法について検討した。生育状況把握手法については、

ドローンによる空撮画像から植栽木の樹高や生存率が推定できることが分かり、簡易な生

育状況把握手法として活用できる可能性が認められた。枯死等の原因については、生育基盤

の採土円筒による調査結果から、枯死、生育不良とも土壌三相構造の気相が低い箇所で起こ

っていたことから、生育基盤の通気性、排水性不良が主な要因と考えられた。枯死、生育不

良改善方法の検討では、滞水気味となり従来の植栽木が枯死した造成地に新たに植栽し、携

帯式穴掘り機を用いて径 20cm、深さ 50cm、１孔/ｍ2 の縦穴を開けたところ、対処後の１

成長期では、穴堀り区は対照区より枯死率が低い傾向があったが、今後長期的観察が必要で

ある。また、枯死発生箇所に新たに植栽した造成地並びに生育不良箇所に枯死、生育不良対

策として１本当たり 30g ずつ 6-4-3 有機化成肥料を施肥したところ、施肥から１年間は根

元径成長量が無施肥区より大きかったが、枯死を改善する効果は認められなかった。 
他方、海岸防災林整備では広葉樹の導入も実施、検討されている。広葉樹はマツ類と比較

して生育の困難が予想され、導入実績も少ないことから、本県の環境に適した樹種選定や植

栽、管理方法について検討する必要がある。そこで、広葉樹とクロマツを混植した造成地に

おいて植栽木の生育状況を調査し、広葉樹の樹種ごとの生育特性をクロマツとの比較によ

り考察した。加えて、海岸防災林に適応する樹種を検索するため、経過年数５年までの造成



地に侵入した木本類を調査した。その結果、広葉樹（タブノキ、ネズミモチ、トベラ）とク

ロマツ混植地では、タブノキ、ネズミモチが良好に生育する場所も見られたが、タブノキは

通気性、排水性不良に対する耐性がクロマツより小さいと考えられ、ネズミモチは通気性、

排水性不良に対する耐性はある程度高いと思われたが、硬い生育基盤で枯死が多かった。ま

た、クヌギ、コナラ、ヤマハンノキ、オニグルミをクロマツとともに通気性、排水性不良の

造成地に植栽した試験地では、広葉樹４種の枯死率はクロマツより高く、いずれも通気性、

排水性不良への耐性がクロマツより低いと考えられた。一方、ヤマハンノキはクロマツと同

程度の成長量を示し、活着すれば造成地でよく成長する可能性が認められた。造成地への侵

入木本類の調査では、確認された侵入木本類のうちヤシャブシが経過年数ごとに被度と樹

高を拡大させていた。ヤシャブシは小高木であるためマツ類を代替することは難しいが、造

成地の土質を改善する可能性があることから、ヤシャブシが侵入した造成地の環境の変化

について注目する必要が認められた。 
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Ⅰ はじめに 
 福島県の海岸林は、江戸時代から防災林として整備され、耕地・農作物や人家・施設を飛

砂、強風、潮風、高波等から保護し、魚つき、航行目標、景観保持、保健休養、生物多様性

をはぐくむ場所として貢献していたが、2011 年３月 11 日に発生した東日本大震災による

津波によりその多くが流失した 22）。福島県は、2013 年に海岸防災林復旧整備の技術的な指

針として「福島県の海岸防災林の再生に向けたガイドライン（以下、県ガイドライン）」を

作成し海岸防災林造成事業を進めている 31）。県ガイドラインにおいて、基盤造成は国の治

山技術基準等を踏まえ、植栽する樹木の直根が十分に成長し、飛砂、風害の防備等に必要な

樹高を有する樹木の成長確保及び津波に対して根返りしにくい林帯を造成するため、基本

的に生育基盤を地下水位から所用の地盤高さ 2.4ｍを確保する盛土により実施するとされ

た。また、造成基盤に主林木として植栽する苗木は、飛砂、潮害、風害に耐えられ、防風効

果を高めるために保全対象に対して十分な樹高があり、かつ、津波被害の低減効果の高い樹

種であるとしてクロマツ並びにアカマツが選定された。さらに、飛砂や強風から植栽木を保

護する目的で造成地には防風柵工、静砂垣工等の対策が規定された７）。この方針の下、福島

県の海岸地域のほぼ全域で造成工事が進められ、2022 年３月末において整備済面積は

620ha８）となり、造成地へのマツ類の植栽として前例がない大規模なものとなった。 
植栽されたマツ類は、クロマツ、アカマツの別、植栽密度、植栽時期を問わず高い活着率

を示し９）、飛砂、強風等への対策が効果を発揮したとも考えられた。しかし、その後の生育

状況は良好な箇所ばかりではなく、一部で枯死や生育不良が発生するなど生育状況に差が

生じていることが海岸防災林管理者から報告された。生育基盤盛土への大規模なマツの植

栽は前例がなく、植栽木の生育に与える要因は不明であるため、復旧整備を進めるにあたり

生育不良の原因解明は急務である。また、造成地は広大であり、かつ用地取得、造成工事、

植栽が整備地域全体において同時並行的に進められたため、様々な植栽年度の造成地がパ

ッチ状に混在することとなり、海岸防災林管理者が植栽木の生育状況を把握するために多

大な時間と労務を要している。このため、省力的な植栽木生育状況把握手法が必要である。

海岸防災林の復旧整備におけるこのような状況を受け、海岸防災林造成や後続する植栽木

の保育、管理への参考とするため、植栽木の簡易な生育状況把握手法、植栽木の枯死、生育

不良の原因究明と対策について検討を行った。 
他方、海岸防災林の造成は、従来クロマツを中心としたマツ類により整備が行われてきた

が、近年では生物多様性保全の観点やマツ材線虫病等の病害虫がまん延した場合に被害分

散を図る必要性から広葉樹を利用する試みが増えている 18）33）。福島県においても、広葉樹

による海岸防災林造成が地域住民から要望され、試験的な植栽が実施、予定されている。し

かし、海岸防災林への広葉樹導入は難しいとされ７）、県内における施工事例も少ない。この

ため、本県の海岸防災林の環境に適した広葉樹種を確認し、造成地における広葉樹の適切な

植栽、管理方法について検討する必要がある。そこで、海岸防災林造成地にクロマツと広葉

樹を混植し、クロマツの生育状況との比較から海岸防災林造成地における広葉樹の生育特

性を樹種ごとに考察した。また、海岸防災林造成地に侵入し生育する木本類を調査し、確認

された樹種から、海岸防災林造成地の環境に適合し構成種たり得る広葉樹の有無を検討し

た。 
 



Ⅱ 海岸防災林植栽木の枯死、生育不良の実態把握 

１ ドローンを使った植栽木の生育状況把握手法の検討 

（１）目的 

東日本大震災からの復旧のため進められている海岸防災林整備は、用地取得等の手続き

が終了した場所から順次、造成工事が行われたため、林齢構成が複雑な配置となっている。

加えて、一部の造成地で植栽木の枯死や生育不良が発生しており、同林齢の造成地でも生

育状況により植栽木の大きさが異なっている。今後、本数調整伐等の実施により、海岸防

災林として成林を目指す必要があるが、造成地は広大であるため、箇所ごとの植栽木の生

育状況を把握するために多大な労力と時間を要する可能性が高い。このため、海岸防災林

植栽木の生育状況把握について省力化技術が求められる。 
近年、森林情報取得の省力化を図るため UAV 等を利用する取り組みが活発になってい

る３）17）。海岸防災林は山域の造林地帯とは異なり平坦な場所が多いため、ライセンスが不

要な目視飛行でもドローンにより比較的簡易かつ広範囲に造成地を空撮できる。この空撮

画像を利用して海岸防災林植栽木の生育状況を把握できれば現地踏査に係る労務、時間を

省力化できる可能性がある。ドローンでレンズを下向きにして撮影を行うと、植栽木の樹

冠が粒～面状に写ることが多く、箇所ごとに濃淡が違って見える。この違いに着目し、空

撮画像における単位面積当たりの樹冠の投影面積（被度）と生存本数（生存率）をフリー

ソフトで数値化して海岸防災林の本数調整伐実施時期の判断指標に位置付けられている

林冠高６）（樹高）及び植栽木の生存数の実測値と比較することにより、空撮画像から植栽

木の樹高、生存率の推定が可能か検証した。 
（２）調査方法 

① ドローン空撮画像による植栽木の樹高推定 
調査は、南相馬市鹿島区北海老地区（図－１）の 2015～2017 年に造成された海岸防

災林で行った。植栽木はクロマツ及びアカマツ、植栽密度は 10,000 本/ha、調査時の林

齢は５～７年生であった。 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

図－１ 調査地の位置 



ドローンによる空撮は、2021 年５月７日 11:00～12:00 に調査地の上空 100～110ｍ
からレンズを下向きにして林齢別に１枚ずつ撮影した。ドローンは、DJI 社「MAVIC 
MINI」を使用した。撮影時の天候は曇りであった。 
植栽木の実測は、林齢別の空撮範囲内において生育状況が異なる 30ｍ2 の区域を 12

区（植栽本数５×５本／区）設定し、同年７月に樹高を実測した（図－２）。 
 
 
 
 
 
 
 
 
 
 
 
 
図－２ 植栽木樹高推定の調査地（北海老地区）及び樹高実測区域（枠内） 

 
ドローン空撮画像における樹高実測区域の被度は、アメリカ国立衛生研究所開発の

フリーソフト Image J13）14）を用いて数値化した。数値化は表－１に示した手順１～８

（被度）により行った（表－１、図－３、４）。 
 
表－１ 空撮画像の解析手順 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

手順1 ImageJを立ち上げ、空撮画像をRGBカラー画面で開く
(File→Open)

手順2 画像のカラー補正をする
(Image→Adjust→Brightness/Contrast→Auto）

手順3 面積の基準となる長さを20mの静砂垣等を利用して設定する
(Analyze→Set Scale)

手順4 一旦保存し、HSBモデルに変換する
(Image→Type→HSB Stack)

手順5 樹高実測区域の植栽マツの樹冠部を指定し、H(Hue)、S(Saturation)、B(Brightness)
の数値範囲を解析する (Analyze→Histogram)    図ー３

手順6 画像を一旦閉じ、再度RGBカラー画面で開く
(File→Open)

手順7 画像上の樹冠と同色部分を閾値設定する
(Image→Adjust→Color Threshold)

手順8
(被度)

計測区域を指定し、区域面積に対する閾値設定部分の割合（＝被度）を求める
(Analyze→Analyze Particles)     図－４

手順8
(生存数)

測定区域を指定し、カウント対象の大きさの範囲を｢Analyze Particles｣ウィンドゥに
入力することで対象の数が返される (Analyze→Analyze Particles)



 
 
 
 
 
 
 
 
 
 
 
 
 
 

図－３ 空撮画像の解析状況（植栽マツの樹冠の色の解析） 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

図－４ 空撮画像の解析状況（被度の算定） 
 

② ドローン空撮画像による植栽木の生存数推定 
調査は、楢葉町山田浜地区（図－１）の 2018 年に植栽された海岸防災林造成地で行

った。植栽木は、４年生クロマツ、植栽密度は 5,000 本/ha である。当調査地は、５つ

の島状の造成区に分かれており（図－５）、ドローンによる空撮は各造成区がそれぞれ

１枚の画像に入るように①と同じ方法で撮影した。撮影日時は 2021 年５月 12 日 11:00
～12:00、天候は晴れであった。 

植栽木の生存数は、造成地に設置されている静砂垣で囲まれた 10ｍ×20ｍブロック

を単位として計 44 ブロックを調査し、ブロックごとに植栽本数（７列×14 本）に対す

る生存本数を数えた。また、植栽木の条件による生存数の推定精度を検証するため、空



撮対象のブロックごとの樹冠幅を２列ずつ抽出し測定した。 
ドローン空撮画像における生存数は、表－１の手順１～７により樹冠に該当する部

分を閾値設定し、手順８（生存数）として画像上の樹冠の大きさに見合う面（かたまり、

つぶ）の数を植栽木の個体数と見なしてカウントした。なお、Image J では対象のサイ

ズ範囲を設定し範囲内の大きさの物体の数をカウントするため、2015～2021 年に南相

馬市で行った海岸防災林植栽木の継続調査の４年生時の樹冠幅測定値より、樹冠投影

面積の範囲を 0.02～1.02ｍ2と想定しサイズ設定に用いた。 
 
 
 
 
 
 
 
 

図－５ 植栽木生存数推定の調査地（山田浜地区） 
（３）結果及び考察 

① ドローン空撮画像による植栽木の樹高推定 
 調査に用いたドローンでは、１回の飛行の継続時間は６～７分で撮影可能な範囲は

１～２ha であった。また、高度 100～110ｍから撮影した場合に画像１枚に写る造成地

の面積は約 5,000ｍ2であった。調査に要した時間は、林齢を同じくする 12 区域を空撮

するために平均７分、空撮画像から 12区域の被度の算定に平均８分であった。対して、

12 区域に生育する植栽木 12×25 本の樹高測定に要した時間は平均 67 分、測定データ

を入力し区域ごとの平均樹高を算出するのに要した時間は平均 12 分であった。 
 HSB モデルで数値解析した空撮画像上の植栽マツの樹冠の色は、画像ごと、個体ご

とに違いはあるが、色相（Hue）は概ね黄色から黄緑色に該当する領域に示された（図

－３の右上小窓）。対して、彩度（Saturation）、明度（Brightness）は広い数値範囲に

示された（図－３の右中、右下小窓）。このため、閾値設定する際は、はじめに彩度、

明度の全域を指定し、色相の該当範囲を設定した後、微調整を行うことで比較的簡単に

設定できた。 
 空撮画像における区域ごとの被度の違いを６年生区での空撮画像で検証したところ、

被度が小さい区域は植栽木の個体ごとに樹冠が小さく分かれて見えるが、被度が大き

くなるとともに隣同士の樹冠が接し合い、被度 90％以上の区域では１本ずつの植栽木

が見分け難くなっていた（図－６）。 
空撮画像から算定した区域ごとの被度と植栽木の樹高実測値の間には５～７年生と

も高い相関が認められ、高年生ほど回帰線の傾きが大きかった（図－７）。また、７年

生では被度 90％以上の調査区で樹高３ｍに達する植栽木が多かった（図－７）。なお、

林冠高３ｍは 10,000 本/ha で植栽された海岸防災林の第１回本数調整伐の目安６）とさ

れている。 
被度と樹高実測値に高い相関が見られたことから、空撮画像より樹高を推定するこ



とは可能と考えられた。また、従来の踏査、実測による把握方法よりも、短時間で省力

的に把握できる可能性が高く、調査範囲が広くなるほど実測に要する時間との差は大

きくなると考えられた。被度と樹高が相関する理由としては、植栽木の個体ごとの樹冠

の大きさと樹高に一定の関係性があり、樹冠の大きさが拡大し被度が高まることと樹

高の伸長が連動するためと考えられた。さらに、植栽木の樹冠同士が接し始まる計算上

の被度 78.5％を超えて以降は急速に樹高の伸長が起こると考えられ、７年生で被度

90％に達した区域では３ｍ以上の植栽木が増えていたことから、植栽密度 10,000 本

/ha における第１回本数調整伐実施の目安としての利用が考えられた。さらに、経過年

数が大きくなるほど成長の良い区域と悪い区域の樹高の差が開くことが考えられた。

なお、本手法の被度は同一画像内における相対値であり、算定される被度は画像ごとに

異なる。このため、撮影条件を検討し、事例を増やして推定精度の向上を図る必要があ

る。 
 
 
 
 
 
 
 

図－６ 被度別の樹冠の状況（北海老地区６年生） 
 
 
 
 
 
 
 
 
 
 
 
 
 

図－７ 被度と樹高実測値の関係 
 

② ドローン空撮画像による植栽木の生存数推定 
画像から推定した生存数の実数との比は、５造成区のうち３区では 10％以下の誤差

で概ね高い精度であったが、他の２区は推定精度が低かった（表－２）。また、精度の

低かった２区は、精度が高かった３区と比較して平均樹冠幅が小さかった（表－２）。

一方、ブロックごとの推定数/実測数比は、どの造成区でも差が大きかった。 
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ブロックごとの樹冠幅を 10cm ごとの階に区分し、推定数/実測数比が 0.8 以下のブ

ロックが占める割合を検討すると、樹冠幅が 50cm 以上の階では推定数/実測数比 0.8
以下のブロックはなかったが、樹冠幅が 40～50cm の階では 56％、それ以下の階では

75～86％が推定数/実測数比 0.8 以下であり、樹冠幅が小さいブロックは推定精度が低

かった（図－８）。 
当生存数推定手法は、植栽から植栽木の樹冠が成長して樹冠同士が接し合う時期ま

で有効と考えられるが、精度が悪くなる要因としては、樹冠が小さいため画像解析で閾

値設定できない、樹冠の色相が黄色よりのため類似した生育基盤表面の色と区別でき

ない、植栽木以外の雑草木と区別できない、等が考えられる。結果より、樹冠幅が小さ

いブロックほど推定数/実測数比が低かったことから、当手法は樹冠幅が大きい（＝成

長の良い）箇所ではある程度高い精度で生存数を推定できるが、樹冠幅が小さい箇所で

は、画像上での樹冠の特定が樹冠の小ささや色の黄色っぽさのため難しく、精度が低く

なると想像された。このため、当手法の精度の向上のためには、植栽木をより鮮明に撮

影できる条件や解像度の高いドローン機種、レンズの使用などを検討する必要がある

と考えられる。 
 
表－２ 造成区ごとの推定数/実測数比及び植栽木の樹冠幅 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

図－８ 樹冠幅の階ごとの推定数/実測数比が 0.8 未満のブロックの割合 
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D 9 0.41(0.11～0.67) 40.4

E 10 0.92(0.60～1.24) 49.9



２ 生育基盤の物理性、化学性調査による植栽木の枯死、生育不良原因の推定 

（１）目的 

東日本大震災後に整備された海岸防災林は、クロマツ、アカマツが主林木として植栽さ

れている８）。植栽されたマツ類の生育状況は、600ha を超える広大な造成地にあって違い

がでており、良好な箇所も多い一方、一部施工地で枯死や生育不良が見受けられる。この

ため、今後の改善策の検討、保育計画の策定への基礎資料となるよう枯死、生育不良の原

因究明を行った。 
海岸での植栽は、山地治山での植栽と比較して、強風害、潮風害、乾燥害等を受けやす

く、また、地温の差が大きく、土壌の保水力が小さいなど、成林にあたっての困難性が著

しく高い 26）。この対策のため、海岸防災林の復旧整備では、防風柵、静砂垣等が標準的に

施工されている。同時に、津波に強い根返りしにくい林帯を創生するため、生育基盤盛土

工による生育基盤の造成が基本的な方針とされた 28）。他方、重機により造成された生育基

盤盛土について、締め固めの過多により水たまりが発生するような固結した土地になりや

すいことが指摘されている 10）15）。さらに、主林木であるクロマツは、海岸特有の環境（潮

風、強風）や貧栄養の砂地に適応した海岸防災林造成に最も適した樹種とされる７）反面、

酸素不足（水分の過剰、土壌が緻密状態）により害を受け易いとされている 12）。このため、

植栽マツの枯死や生育不良の要因として生育基盤盛土の硬さ等の物理性、pH 等の化学性

に注目し、マツの生育状況と生育基盤盛土の状態との関係について検討した。 
（２）調査地及び調査方法 

調査は、楢葉町山田浜地区（図－１）において 2018 年にクロマツが植栽密度 5,000 本

/ha で植栽された合計約 1.6ha の造成地で行った。当調査地は、生育基盤盛土工で造成さ

れた５つの工区が分散して配置され、植栽木の生育が良好な場所から枯死が目立つ場所ま

で様々な生育状況が見受けられた。なお、当調査地はⅡ－１の「ドローンを使った植栽木

の生育状況把握手法の検討」と同箇所である（図－５） 
造成地の土壌の硬度は、2021 年 11 月に SH 式土壌貫入試験機を使用し、概ね 100ｍ2

に１箇所ずつ測定した。当試験機は、重さ３kg の錘を１ｍの高さから落下させた打撃によ

り測定杭が土壌に貫入する長さを連続して読み取ることで、深度ごとの土壌の硬さを測る

仕組みとなっているが 11）、１箇所の測定においては 50cm 深に達するまで打撃を繰り返し

て数値を読み取り、50cm 深までに 0.4mm/打撃以下が３回以上連続する硬い地盤に達し

た場合は、試験機の破損防止のため測定を終了し、以深から 50cm までの硬度は最終の打

撃による計測値と見なした。 
生育基盤の硬度以外の物理性及び化学性は、2022 年５月に植栽木の生育状況の異なる

25 地点を選定し、400ml 採土円筒で各地点１箇所ずつ、深さ 15～19cm 部分を採取して

測定した。測定項目は、飽和透水係数、粗孔隙率、細孔隙率(全孔隙率－粗孔隙率）、三相

構造、pH、及び EC で、土壌採取及び物理性測定は、河田・小島（1979）21)に従い、土粒

子の比重は花崗岩、長石類、粘土類に相当する 2.65 とし、透水速度の測定は定水位法で行

った。また、pH と EC は採土円筒試料の細土 10ｇに水 50ml を加えて 1 時間振とうした

後、pH はガラス電極式 pH メーター（堀場製作所 D-51）、EC は土壌導電率計（シンワデ

ジタル電気伝導率計 72758）により測定した。 
植栽木の生育状況は、2022 年５月、土壌採取を行った 25 地点の周囲の植栽木４×４本



を対象として苗長、根元径及び枯死本数を測定し、生育状況の指標としては D2H（根元径
２×苗長）を算定した。 

（３）結果及び考察 

SH 式土壌貫入試験機による生育基盤の硬さの測定結果は、生育基盤の深さ 15cm にお

けるＳ値（土の軟らか度：貫入試験機の１打撃貫入量を cm で表した値）11）と植栽木の枯

死率、及び S 値と D2H の双方ともに相関関係は認められなかった。また、植物の多くの

根が侵入困難とされるＳ値 0.7 以下 11）で枯死がない地点やＳ値 0.7 以上で枯死率 100％
の地点が存在し（図－９）、Ｓ値 0.7 以下でも D2H が高かった地点は多かった（図－10）。 

400ml 採土円筒による物理性、化学性調査では、測定項目のうち土壌三相構造の気相と

枯死率の間に相関が確認され（図－11）、三相構造の気相、飽和透水係数、pH と植栽木の

D2H の間に相関が確認された（図－12～14）。 
震災後に整備されている海岸防災林では、重機による締め固めの過多により固結した生

育基盤が認められることが指摘されている 30）。これに対し、本調査では生育基盤の硬さの

指標である S 値と植栽マツの枯死率及び生育状況の指標と位置付けた D2H に関係性は認

められなかった。このため、海岸防災林における植栽マツの枯死、生育不良は、生育基盤

の硬さが根の伸長等に直接的に関与し起こっているのではないことが示唆された。クロマ

ツは、岩石海岸、砂地に多く生育し、深根性で潮風に対する耐性が大きい 32）。このため、

造成地の生育基盤が一般的な他の植物の根が伸長し難い硬い土壌条件であっても、クロマ

ツは生存率が高く、場合によっては良好に生育することが窺えた。一方、クロマツはアカ

マツと共に排水がよく透水性で空気の含量の多い土壌を好み、排水が良くても粘土成分が

多いところでは形質も成長もよくないとされる 34）。枯死率、D2H と相関があった三相構

造の気相は、通気性や排水性に関係し根の伸長に密接に関連するとされ、気相の不足は作

物の湿害の原因となり、転換畑では少なくとも 20％以上は必要とされる１）。本結果でも、

植栽木の枯死が 50％以上の調査地点は気相が 20％未満であり（図－11）、また D2H と相

関があった飽和透水係数も透排水性に係る指標である。これらより、枯死、生育不良の直

接的な要因として、生育基盤の通気性、排水性の不良が考えられた。 
東日本大震災で被災した海岸防災林の復旧事業では、津波に強い根返りしにくい林帯を

創生するため７）これまでの一般的な海岸林の造成と異なって、植栽に先立ち植栽基盤盛土

が造成されている場所が多い 28）。本県以外でも、海岸防災林復旧工事で滞水や排水不良に

より一部区域で植栽木の枯死や不健全な生育が発生したことが報告されている 16）19）。ま

た、重機で造成された植栽基盤では固結や通気通水不良により根の伸長阻害などが起きや

すいことが指摘されていたことから 10）、生育基盤盛土工により造成された海岸防災林の

特有の現象として植栽木の枯死や生育不良が起こったとも考えられた。盛土で造成された

生育基盤で通気性、排水性不良が起こる原因としては、重機による締め固めに伴う固結 30）

や風化すると粘土化する鉱物を含む山砂の使用 25）等が指摘されている。一様に造成され

た生育基盤盛土にあっても施工場所ごとに重機による締め固めの度合いや盛土材の粘土

成分割合等が異なることが、生育状況の箇所による違いの要因として考えられた。また、

締め固めに由来すると思われる生育基盤の硬さと植栽木の枯死率、D2H は相関関係が認め

られなかったことは（図－９、10）、同じ土質なら土壌硬度が小さいほど含水率が高く 37）、

硬度の小さい場所が滞水気味となり易いと考えられることから、生育基盤の硬さや成分の



分布や配置により枯死、生育不良が起こりやすい場所が現れると考えられた。一方、D2H
との相関が認められた生育基盤の pH については、測定値が 4.8～6.6 と弱酸性の範囲であ

り（図－14）、生育不良に塩害、潮害が関わっているとすれば pH は 7.0 を超えるためそ

の可能性は低く、栄養成分の蓄積量などを介して生育状況との間に相関が現れたものと考

えられた。以上より、本調査結果から考えられる植栽木の枯死、生育不良の原因は、生育

基盤の通気性、排水性不良であり、対策としては造成地の耕起や暗渠排水の追加等４）が想

定される。 
 
 
 
 
 
 
 
 
 
 

図－９ 生育基盤の深さ 15cm における S 値と枯死率の関係 
 
 
 
 
 
 
 
 
 
 

図－10 生育基盤の深さ 15cm における S 値と植栽木の D2H の関係 
 
 
 
 
 
 
 
 
 
 

図－11 生育基盤の気相と植栽木の枯死率の関係 
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図－12 生育基盤の気相と植栽木の D2H の関係 
 
 
 
 
 
 
 
 
 
 
 
 

図－13 生育基盤の飽和透水係数と植栽木の D2H の関係 
 
 
 
 
 
 
 
 
 
 
 
 

図－14 生育基盤の pH と植栽木の D2H の関係 
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Ⅲ 植栽木の枯死、生育不良の改善方法の検討 

１ 携帯式穴掘り機による枯死、生育不良改善の検討 

（１）目的 

東日本大震災後に造成され、マツ類が植栽された海岸防災林の一部で植栽木の枯死や生

育不良が確認された。海岸防災林における植栽木の枯死、生育不良原因の検討の結果、植栽

木の枯死や生育不良は生育基盤の通気性、排水性が不良な場所で多く発生していると考え

られた（Ⅱ－２参照）。このため、植栽木の枯死、生育不良対策として、生育基盤に停滞し

がちな水分を排水することが考えられた。造成、植栽が完了した生育基盤において、重機の

使用による大規模な改良を行うことなく排水性を改善する方法の一つに、携帯式穴掘り機

を使用して縦方向に掘削し、生育基盤の表面付近の水分を下方に処理する方法がある 23）。

本方法は、水田転作野菜栽培等田畑の簡易な局所排水対策に効果があるとして紹介されて

いる 24）35）。そこで、海岸防災林造成地で排水不良となり、枯死が発生した造成地において

新たに苗木を植栽し、携帯式穴掘り機による縦方向の掘削で植栽木の枯死率及び成長量が

改善するか検討を行った。 
（２）調査地及び調査方法 

調査は、楢葉町山田浜地区海岸防災林（図－１）の生育基盤盛土工により造成された海岸

防災林で行った。当造成地は、概ね 60ｍ×90ｍの島状の形状をなし、上部の植栽木の生育

基盤は平坦で、2018 年に 0.30ha の面積に 5,000 本/ha の密度（海岸側の一部は 10,000 本

/ha）でクロマツが植栽された（図－15）。2022 年９月時点の植栽木の生育状況は良好な部

分と生育が不良な部分が混在しており、中央付近の 500ｍ2 程度の範囲で植栽木が集団的に

枯死した箇所が見られた。枯死発生箇所は、粘土成分が多く強くぬかるみ、降雨後には生育

基盤表面が水たまりになっていることが多かった（図－16）。当該枯死発生地を試験地とし

て携帯式穴掘り機による生育基盤の改善試験を行った。 
2022 年 11 月、試験地を穴掘り区と対照区に分け（図－17）、生育基盤の物理性を事前に

把握するため、生育基盤の深さ 15～19cm 部分を 400ml 採土円筒で両区から５箇所ずつ採

取した。土壌採取及び測定方法については、Ⅱ－２と同様とした。その後、2022 年 11 月 22
日、エンジン付携帯式穴掘り機（ゼノアAGZ2600EZ）にφ20cmドリルを装着し、深さ50cm、

１箇所/ｍ2の割合で真下方向に掘削した。 
試験地への植栽は、穴掘り後の 2022 年 12 月７日にクロマツ（マツ材線虫病抵抗性）、ク

ヌギ、コナラ、ヤマハンノキ、オニグルミの２年生裸苗を均等の配列で穴掘り区と対照区と

も 35 本ずつ植栽した（図－17）。樹種の選定は、県ガイドラインで海岸防災林整備事業の

主林木に位置付けられるクロマツ、また植栽可能な「基本樹種」に位置付けられている広葉

樹より選定した。植栽方法は、海岸防災林整備事業におけるマツ類の標準植栽方法に即し、

15cm 程度の植え穴をスコップで掘り、植え穴に成分比 6：4：3 の化成肥料を 30g/本投入し

植え付けた。 
植栽木は、植栽時に苗長と根元径を測定し、2023 年４月 27 日に冬期間中の枯死数を確

認後、2023 年 10 月 25 日に最終的な枯死数、苗長、根元径を測定した。なお、成長量は、

最終確認日に生残していた植栽木における最終確認日と植栽時の D2H（根元径 2×苗長）の

差として算定した。 
 



 
 
 
 
 
 
 
 
 
 
 
 

図－15 携帯式穴掘り機効果調査地及び広葉樹４種とクロマツ植栽 
調査地の位置（山田浜地区：2021 年撮影） 

 
 
 
 
 
 
 
 
 

図－16 携帯式穴掘り機の効果調査地の滞水状況 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

図－17 携帯式穴掘り機効果試験地の植栽図 
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（３）結果及び考察 

採土円筒による生育基盤の物理性は、通気性、排水性に関係する指標である粗孔隙率、三

相構造の気相が、穴掘り区、対照区とも畑での許容値 20％１）を下回った地点が多かった（表

－３）。また、透水係数、粗孔隙率、気相において穴掘り区と対照区に統計的な違いは確認

されなかった（３項目ともＵ検定：ｐ>0.5）。このため、試験地の生育基盤は全体として一

様に通気性、排水性不良であることが確認された。 
2023 年４月 27 日に調査した冬期間中のクロマツの枯死は、調査地全体で２本（2.9％）

と少なかったが、クヌギは 27 本（38.6％）、ヤマハンノキは 23 本（32.9％）が枯死してい

た。コナラは２本（2.9％）、オニグルミは 12 本（17.1％）であった。その一方、2022 年 11
月から 2023 年４月の降雨量は平年以下で、特に１～２月の厳冬期の降水量は 13.5mm と

少なかった（表－４）20）。このため、枯死が多かった樹種は、調査地の生育基盤の通気性、

排水性不良が原因ではなく、冬期間の乾燥等別の要因で枯死した可能性も考えられた。そこ

で、穴掘り機使用による枯死の防止効果は、４月から 10 月の枯死率により検討した。 
 
表－３  
携帯式穴掘り機の効果検証試験地の 
物理性調査結果                                   
 
 
 
 
 
 
 
 
 
 
 
 
 
４月から 10 月の植栽木全体の枯死率は、穴掘り区 32.2％、対照区 46.4％で穴掘り区が

低かった。樹種ごとの枯死率は、対照区ではクロマツ 17.6％、クヌギ 36.8％、コナラ 33.3％、

ヤマハンノキ 57.1％、オニグルミ 90.3％であったのに対し、穴掘り区ではクロマツ 5.9％、

クヌギ 29.2％、コナラ 40.0％、ヤマハンノキ 26.9％、オニグルミ 63.0％と４樹種で穴掘り

区が対照区を下回り、ヤマハンノキ、オニグルミ、クロマツの順で穴掘り区と対照区の枯死

率の差が大きかった（図－18）。コナラは、穴掘り区の枯死率が対照区より大きかったが、

差は 6.7％と小さかった。一方、植栽後の１成長期における成長量は、各樹種において統計

的有意差は認められず、穴掘り区と対照区の大小の傾向も見られなかった。 
結果より、調査地は通気性、排水性不良のため苗木の活着や生育に厳しい環境と考えられ

たが、コナラ以外の４樹種は、穴掘り機による生育基盤の掘削により、植栽木の枯死が軽減

表－４  
2022 年 11 月～2023 年 10 月の降水

量（アメダスデータ(広野)を転記） 



された可能性が考えられた。また、枯死を防止する効果の大きさは樹種により異なる可能性

が認められ、樹種ごとの通気、排水性不良への耐性の違いが反映することが考えられた。さ

らに、海岸防災林の主林木であるクロマツに対しても効果がある可能性が示唆された。一方、

成長量に違いが認められなかったことは、調査期間が１成長期と短いことや、海岸の環境に

最も適した樹種とされるクロマツ７）が枯死する悪条件下において実施した試験であること

が起因した可能性が考えられた。 
以上から、携帯式穴掘り機を使用し縦方向に穴掘りを行うことにより、通気性、排水性不

良の造成地において植栽木の枯死を軽減できる可能性が認められたが、植栽木の生育不良

への改善効果については不明で、さらに継続期間や条件を変えて検討する必要がある。なお、

当調査は同一の条件下において穴掘りの有無のみによる効果の違いを検討したものであり、

穴掘り機を用いた海岸防災林植栽木の生育状況の改善をさらに検討するためには、生育基

盤や穴掘り方法等の条件を変えて調査する必要がある。 
 
 
 
 
 
 
 
 
 
 
 

図－18 穴掘りの有無のよる樹種ごとの枯死率（４～10 月） 
 
 

２ 枯死、生育不良箇所への施肥の効果 

（１）目的 

東日本大震災後に造成されマツ類が植栽された海岸防災林の一部では、植栽木の枯死や

生育不良が確認されており、改善手法を検討する必要がある。生育基盤の物理性、化学性の

検討の結果、植栽木の枯死、生育不良の原因として、生育基盤の通気性、排水性不良が最も

大きい要因と考えられた（Ⅱ－２参照）。その一方、海岸での植栽は元来、一般的な山地治

山での植栽と比較して環境が厳しく 26）、また主に、山砂等を盛土して造成された生育基盤

に植栽されているため、栄養分が欠乏しがちであることも想像され、貧栄養等の他の要因が

生育不良等の要因として関わっている可能性は考えられる。そこで、施肥による生育基盤の

貧栄養の改善効果に着目し、整備事業で植栽されたクロマツが生育不良となっている造成

地及び枯死が集団的に発生した造成地に新たにクロマツを植栽した試験地に施肥を行い、

生育不良及び枯死発生への効果を検証した。 
（２）調査地及び調査方法 

調査地は楢葉町山田浜地区海岸防災林（図－１）にあり、2016 年の海岸防災林整備事業
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において生育基盤盛土工により造成された。生育基盤は、概ね 50ｍ×80ｍの四角形の島状

の形状をなし、上部の平坦な部分に植栽密度 5,000 本/ha でクロマツが植栽された。植栽時

（2016 年）には、6-4-3 有機化成肥料 30ｇ/本の投与が標準施工された。2021 年の調査開

始時（６年生）において、植栽木の枯死や生育不良が造成地の広範囲に見られた。当造成地

の枯死がない約 400ｍ2 区域を生育不良造成地への追肥試験地（以下、追肥試験地）とし、

植栽クロマツの枯死が集団的に発生した約 250ｍ2の区域にクロマツを補植し施肥の効果を

検討する試験地（以下、補植試験地）とした（図－19）。 
 
 
 
 
 
 
 
 
 
 
 
 
 

図－19 施肥効果試験地の位置（山田浜地区：2021 年撮影） 
 
調査に先立ち、調査地の生育基盤の物理性及び EC を測定した。測定は、400ml 採土円筒

及び SH 式土壌貫入試験機を用いて追肥試験地、補植試験地双方の３箇所で行い、採取法、

測定法についてはⅡ－２と同様とした。 
追肥試験地への施肥は、2021 年７月 18 日、区域内の 14 植栽列のうち１植栽列おきの７

植栽列を対象に、海岸防災林整備事業での植栽時に行われている同じ方法で 6-4-3 有機化成

肥料を 30ｇ/本ずつ、植栽木の幹から 20cm 周囲を 10cm 程度掘って投入し埋め戻した。追

肥本数は 78 本、追肥なし本数は 76 本である。 
補植試験地の設置は、追肥試験と同日の 2021 年７月 18 日に行った。補植に使用した苗

木は、福島県林業研究センターで生産したマツ材線虫病抵抗性クロマツの３年生コンテナ

苗を使用し、1.4ｍの植栽間隔を空け、12 本×８列を植栽した。植栽後に追肥試験地と同様

に１植栽列ごとに施肥を行い、施肥有りの本数は 49 本、施肥なしは 51 本である。 
調査対象木は、調査区設置時に苗長と根元径を測定し、１年が経過した 2022 年８月 28

日、２年が経過した 2023 年８月 28 日に生存の有無、苗長、根元径を確認した。 
（３）結果及び考察 

調査地の生育基盤の物理性、EC 測定結果は表－５のとおりで、通気性、透水性に関係す

る指標となる粗孔隙率は、追肥試験区で 2.92～7.29％、補植試験区で 1.01～9.54％と全調

査地点で畑における最低必要値である 10％１）を下回り、同じく通気性に関係する指標であ

る気相は、追肥試験区で 5.25～10.29％、補植試験区で 6.51～13.44％で畑における最低必



要値 20％１）を下回っていた。さらに、EC は追肥試験区で平均 42μS/m、補植試験地で平

均 48μS/m と畑等と比較して低かった。各測定値のうち、追肥試験地と補植試験地で違い

が認められた項目は、植物の多くの根が侵入困難とされるＳ値 0.7 以下 11）となる深さであ

った。 
表－５ 施肥の効果試験地生育基盤の物理性及び EC 

 
 
 
 
 
 
 
 
 
 
追肥試験地及び補植試験地において補植・施肥から１年後までと１年後から２年後の枯

死数、及び成長量を表－６に示す。試験区設置後の１年間に、追肥試験地では枯死は発生せ

ず、根元径成長量が追肥有りで 7.20mm、追肥なしで 4.52mm となり、追肥有りが有意に

高かった（ｔ検定：p<0.01）。補植試験地では施肥有りで７本、施肥なしで４本の枯死が発

生し、根元径成長量は施肥有りが 2.74mm、施肥なしが 1.80mm とやはり施肥有りの成長

量が有意に高かった（ｔ検定：p<0.01）。しかし、１年後から２年後までの１年間では、追

肥試験地では追肥有りが 3.64mm、追肥なしが 4.46mm、補植試験地では施肥有りで

2.61mm、施肥なしで 2.39mm と両試験地ともに有意差はなくなっていた。また、１年後か

ら２年後までに追肥試験地の枯死はなかったが、補植試験地は施肥有り 10 本、施肥なし２

本が枯死した。加えて、苗長の成長量については両試験地、１、２年目ともに施肥の有無に

よる有意差は認められなかった。 
生育基盤の測定結果より、当該試験地は震災後に整備され、枯死や生育不良が見られてい

る多くの造成地と同じく生育基盤が通気性、排水性が不良と考えられ、同時に貧栄養の状態

にあることが疑われた。試験地への施肥の結果、追肥試験地、補植試験地とも施肥後１年間

の根元径成長量が対照より有意に高かったことから、生育不良箇所、枯死発生箇所とも施肥

により根元径の成長を促進することが可能と考えられた。一方、施肥の１年後から２年後ま

での期間に両試験地で成長量に違いがなかったことから、30g/本程度の施肥による有効期間

は約１年と考えられた。さらに、枯死発生箇所に新たに植栽した補植試験地では補植から１

年後まで、１年後から２年後まで 12 本ずつが枯死し、施肥有りの枯死本数が対照を上回っ

たことから、施肥により根元径の成長を１年程度促進できても枯死の軽減はあまり期待で

きず、通気性、排水性不良等の枯死が発生する要因を改善しなければ枯死の防止には繋がり

にくいことが窺われた。 
 
 
 



 
表－６ 追肥試験地及び補植試験地における枯死数、成長量 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Ⅳ 海岸防災林における広葉樹に関する調査 

１ クロマツと広葉樹の混植試験 

（１）目的 

東日本大震災で被災した海岸防災林の復旧整備にあたり、県ガイドラインは主林木をク

ロマツ、アカマツと定め、特に海岸寄りの林帯ではクロマツを植栽することを定めている７）。

一方、生物多様性保全の観点やマツ材線虫病がまん延した場合の対策から海岸防災林へ広

葉樹を導入する試みが各地で取り組まれている 18）33）。さらに、主林木と定められるマツ類

が植栽された造成地の一部で植栽木の枯死や生育不良が確認されており、マツ類が不成績

な造成地でマツを代替する樹種への要望も高まっている。県ガイドラインにおいては、広葉

樹は内陸側概ね 100ｍまでのゾーンで、できる限り植栽地に従来自生する樹種であれば導入

が認められており、植栽可能な基本樹種とその他の樹種が定められているが、同時に、タブ

ノキ等の広葉樹の植栽が本県において難しいとの報告、見解も掲載されている７）。このため、

海岸防災林に広葉樹を導入する場合の造成地における生育について検討する必要がある。 
震災後に造成された海岸防災林は、一般的に行われてきた海岸砂地へ直接植栽する方法

とは異なり、植栽木の生育基盤盛土が実施されている場合が多い 28）。加えて、防風柵、静

砂垣が標準整備されているため、従来の海岸の環境で生育困難とされる広葉樹種が造成地

で生育する可能性は考えられる。他方、生育基盤盛土に植栽されたマツ類は、生育基盤の通

気、排水不良が主因と考えられる枯死、生育不良が認められていることから（Ⅱ－２参照）、

この場合にマツ類を代替する樹種は、マツ以上の通気、排水不良への耐性を有する必要があ

るとも考えられる。以上のような条件を踏まえ、海岸防災林への広葉樹導入の可能性と生育

を主林木であるクロマツとの比較により確認することとし、広葉樹３種とクロマツを混植

した植栽地における広葉樹の生育状況をエリアによる生育基盤の違いごとに調査した。ま

た別に、滞水気味となりクロマツの枯死が発生した造成地に県ガイドラインで植栽可能な



基本樹種と位置付けられている広葉樹４種をクロマツと混植し、広葉樹の生育状況を調査

した。 
（２）調査地及び調査方法 

① 広葉樹３種とクロマツの混植地における生育状況調査 
調査地は、楢葉町の海岸防災林山田浜地区にあり（図－１）、2018 年にタブノキ、ネ

ズミモチ、トベラが地元からの要望により選定され、クロマツと共に混植された。広葉

樹３種は、県ガイドラインで基本樹種とは別に植栽が可能な樹種として指定されてい

る。混植区域の全体面積は約 3,200ｍ2 で、クロマツ・タブノキ区とクロマツ・ネズミ

モチ・トベラ区に分かれ（図－20）、クロマツ・タブノキ区は面積約 1,400ｍ2、本数比

率１：１、クロマツ・ネズミモチ・トベラ区は面積約 1,800ｍ2、本数比率２：１：１に

均等な配列で植栽され（一部ではトベラの植栽がなく、クロマツ、ネズミモチが１：１

で植栽）、植栽密度は両区共に 5,000 本/ha である。 
植栽木の測定は、植栽当初の 2018 年秋と４成長期を経た 2022 年秋に生存数、根元

径、樹高を測定し、静砂垣で囲まれた 22 のエリア（a～v エリア）別に樹種ごとの生存

率及び成長量を算定した。なお、成長量は 2018 年と 2022 年の D2H（根元径 2×樹高）

の差とした。 
また、エリアごとの生育状況の違いの要因を検討するため、生育基盤の物理性を測定

した。測定は、静砂垣で囲まれたエリアごとに、クロマツ・タブノキ区ではタブノキの

生存率が異なったエリア、クロマツ・ネズミモチ・トベラ区ではクロマツとネズミモチ

の生存率が異なったエリアにおいて通気性、排水性に係る項目を調査し比較した。物理

性測定は、2023 年５月に 400ml 採土円筒及び SH 式土壌貫入試験機を用い、比較する

エリアごとに３箇所ずつ実施し、採取法、測定法についてはⅡ－２と同様とした。 
 
 
 
 
 
 

図－20 クロマツ及び３広葉樹の混植地の区画配置（山田浜地区） 
 

② 枯死が発生した造成地における広葉樹４種とクロマツの植栽試験 
調査は、楢葉町山田浜地区海岸防災林において実施した。調査地設置箇所では、2018

年に海岸防災林整備事業でクロマツが植栽され、調査時までに約 500ｍ2に集団的枯死

が発生している。なお、当調査地は、Ⅲ－１「携帯式穴掘り機による枯死、生育不良改

善の検討」の無処理区と一致する（図－15）。 
2022 年 12 月７日、枯死発生箇所の約 250ｍ2部分に、クヌギ、コナラ、ヤマハンノ

キ、オニグルミ及びクロマツを図－17 の配列により各樹種 35 本ずつ植栽した。選定し

た広葉樹４種は、県ガイドラインで植栽可能な広葉樹の基本樹種に位置付けられた樹

種である。植栽は、マツの植栽を想定した海岸防災林整備事業における標準植栽方法に

準じて植え穴を掘り、6-4-3 有機化成肥料 30g/本を投入し埋め戻した。植栽後、2023 年



４月 27 日と 10 月 25 日に生存数を確認し、冬期間と夏期間の枯死率及び１成長期にお

ける成長量（2023 年 10 月に生残した個体の D2H（根元径 2×苗長）の植栽時からの増

加分）を測定した。 
（３）結果及び考察 

① 広葉樹３種とクロマツの混植地における生育状況調査 
植栽から 4 年後の生存率は、クロマツ・タブノキ区ではクロマツ 76％、タブノキ 38％

とタブノキの生存率は低かった。クロマツ・ネズミモチ・トベラ区では、クロマツ 80％
に対しネズミモチは 77％とクロマツの生存率との差は小さかった。トベラの生存率は

69％で、クロマツよりやや低い結果となった（表－７）。成長量は、広葉樹３種はいず

れもクロマツの１割以下と低かった（表－７）。一方、タブノキ、ネズミモチが良好に

生育しているエリアも見受けられた（図－21）。  
 
表－７ 広葉樹３種とクロマツ混植地における樹種ごとの生存率、D2H 成長量 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

図－21 海岸防災林造成地で生育するタブノキ（左）、ネズミモチ（右） 
 
生存率をエリアごとに検討すると、クロマツ・タブノキ区においては、タブノキは全

エリアでクロマツより低く、特にクロマツの生存率が低い l、r、s エリアでは、極めて

低かった（図－22）。クロマツ・ネズミモチ・トベラ区においては、b、c、d エリアで

ネズミモチ、トベラの生存率がクロマツより高く、ネズミモチは n、t、v エリアでもク

混植区名／樹種 植栽本数 生存本数 生存率 D
2
H(cm

3
)平均

クロマツ・タブノキ区
クロマツ 325 246 75.7% 2,113
タブノキ 323 123 38.1% 199

クロマツ・ネズミモチ・トベラ区
クロマツ 451 362 80.3% 2,726
ネズミモチ 235 180 76.6% 237

トベラ 208 143 68.8% 116
クロマツ集計 776 608 78.4% 2,478



ロマツより生存率が高かった（図－23）。 
 
 
 
 
 
 
 
 
 
 

図－22 クロマツ・タブノキ区の４年後生存率 
 
 
 
 
 
 
 
 
 
 
 
 

図－23 クロマツ・ネズミノチ・トベラ区の４年後生存率 
 
クロマツ・タブノキ区において、クロマツの生存率が同程度でタブノキの生存率が低

い f エリアとタブノキの生存率が高い h エリアの生育基盤の物理性を比較したところ、

気相率が f エリアで 21.3％、h エリアで 31.5％と異なり、h エリアが高かった（表－

８）（Ｕ検定：ｐ<0.05）。また、クロマツ・ネズミモチ・トベラ区において、生育基盤

の物理性を a エリア（クロマツとネズミモチの生存率が高い）、c エリア（ネズミモチ

の生存率が高い）、j エリア（ネズミモチの生存率が低い）で比較した結果、気相率、粗

孔隙率に統計的な違いは確認されなかったが、j エリアは深さ 15cm 以深で植物の根の

伸長が困難となる硬さとされる S 値が 0.7 以下 11）となっており、比較的浅い深度から

硬い土質となる生育基盤であることが認められた（表－８）。 
海岸の環境下で植栽が難しいとされるタブノキやネズミモチが、エリアによっては

良好に生育することが認められた結果は、海岸防災林整備事業において、海岸特有の環

境から植栽木を保護するため防風柵や静砂垣を設置した効果とも考えられ、生育基盤

の条件に適合すれば広葉樹でも海岸防災造成地で良好に生育すると考えられた。 
また、生存率と生育基盤の物理性の測定結果より、広葉樹３種の海岸防災林造成地に
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おける生育特性をクロマツが通気性、排水性不良への耐性が低いとの前提に立ちクロ

マツと比較すれば、タブノキは通気性、排水性不良への耐性がクロマツよりさらに低く、

気相率 31％程度の生育基盤であれば良好に生育する可能性がある反面、気相率 21％程

度の通気性、排水性不良の生育基盤では枯死する可能性が高いと考えられた。対して、

ネズミモチは、通気性、排水性不良の造成地でも、ある程度生存率が高いと考えられた

が、浅い位置から硬い土質となる生育基盤で生存率が低くなる可能性が認められた。ま

た、トベラについては、ネズミモチの生育特性に類似する可能性が考えられたが、低木

であるため、林縁等での活用が適当と思われた。 
広葉樹３種の成長量がいずれもクロマツの１割以下であったことについては、陰樹

と陽樹、低木～高木等の違いにより成長速度や成長時期が違うことが容易に想像され、

植栽から４年間における本結果のみから海岸防災林への適否を判断することは困難で

ある。例えば、陽樹で先に成長するクロマツが成長の遅い広葉樹の生育環境を準備し、

広葉樹が遅れて良好に成長する可能性も考えられる。このため、海岸防災林における広

葉樹の生育は継続して観察する必要があると思われる。 
 
表－８ クロマツと広葉樹３種混植試験地生育基盤の物理性 
 
 
 
 
 
 
 
 
 
 
 

※アスタリスク：エリア間に有意差がある。 

 
② 枯死が発生した造成地における広葉樹４種とクロマツの植栽試験 

植栽後の 2022～2023 年の冬期間は、降水量が平年より低かった（Ⅲ－１参照）。2023
年４月に確認した冬期間の枯死率は、低い順にクロマツ 2.9％、コナラ 5.7％、オニグ

ルミ 11.4％、ヤマハンノキ 40.0％、クヌギ 45.7％で、広葉樹４種の枯死率は、クロマ

ツより高かった（図－24）。 
４月から 10 月の夏期間は平年並みの降水量があり、クロマツは４月の確認時に生存

していた植栽木のうち、冬期間より多い 17.6％が枯死した。対して、広葉樹はいずれ

も枯死率がクロマツより高く、コナラ 33.3％、クヌギ 36.8％、ヤマハンノキ 57.1％、

オニグルミ 90.3％の順で高かった（図－24）。成長量は、大きい樹種から順にヤマハン

ノキ 55.5％、クロマツ 52.0％、コナラ 29.9％、クヌギ 27.4％、オニグルミ－12.7％で、

ヤマハンノキはクロマツを上回った。一方、オニグルミは、生残していても先枯れした



個体が多く、成長量がマイナスとなった（図－25）。 
 
 
 
 
 
 
 
 
 
 
 

図－24 クロマツ及び広葉樹４種の枯死率 
 
 
 
 
 
 
 
 
 
 
 

図－25 クロマツ及び広葉樹４種の成長量（４～10 月） 
※エラーバー：標準誤差 
 

本調査は、海岸防災林に最も適した樹種７）として主林木に規定されるクロマツが枯

死した劣悪な生育基盤で実施した１事例であるため、上に示した枯死率や成長量が海

岸防災林造成地全般に当てはまるものではないが、県ガイドラインで植栽可能な広葉

樹の基本樹種と規定されたクヌギ、コナラ、ヤマハンノキ、オニグルミは、冬期間、夏

期間ともクロマツより活着率が低いと考えられた。また、海岸防災林造成地へ植栽され

たクロマツコンテナ苗が植栽時期によらず活着率が高かったと報告されている 36）のに

対し、クヌギ、ヤマハンノキ等は植栽時期が限定される可能性が窺われた。さらに、夏

期間の枯死率の結果を受けクロマツが通気性、排水性不良の生育基盤への耐性が比較

的低いと仮定した場合、当該４広葉樹の通気性、排水性不良への耐性はクロマツよりさ

らに低いと考えられた。このため、マツ類と同じ植栽方法をとった場合にクロマツを代

替することは難しいと考えられる。他方、ヤマハンノキはクロマツ並に成長量が大きか

ったことから、活着率を上げれば海岸防災林造成地において良く成育し、クロマツを代

替する可能性も認められた。 

-20
-10

0
10
20
30
40
50
60
70
80

クロマツ クヌギ コナラ ヤマハンノキ オニグルミ

成
長
量

(cm
3 )



 
２ 造成地に侵入した木本類の調査 
（１）目的 
東日本大震災で被災した海岸防災林の復旧整備にあたり、県ガイドラインは主林木をク

ロマツ、アカマツと定め、広葉樹については肥料木としての利用のほか、地域等ニーズや生

物多様性保全の観点から内陸側のゾーンを中心に植栽が認められている７）。一般に海岸防災

林への広葉樹の導入は、潮風や貧栄養の環境により困難と考えられているが７）、マツ類が不

成績な造成地でマツを代替する樹種選定への期待は高まっている。海岸防災林に導入する

広葉樹は福島県の海岸防災林造成地の環境に適した樹種である必要があるが、造成地に樹

木を植栽し、生育状況を確認するには長期間を要する。一方、海岸防災林造成地では周辺環

境から飛来、もしくは生育基盤盛土の材料として搬入された土砂に混入していた種子由来

と考えられる木本類の発生が観察される。このような侵入木本類に良好に生育するものが

あれば、海岸防災林造成地の環境に適する樹種として利用できる可能性がある。そこで、福

島県の海岸防災林に適した広葉樹検索のため、造成からの経過年数が異なる複数箇所にお

いて侵入木本類の種類と生育状況を調査した。 
（２）調査地及び調査方法 
調査は、南相馬市鹿島区北海老地区及び楢葉町山田浜地区の 2015～2019 年に造成され

た海岸防災林で行った（図－１）。2020 年９～10 月、静砂垣で囲まれた 10ｍ×20ｍの区域

を単位とし、北海老地区 248 区域、山田浜地区 146 区域を対象に生育している侵入木本類

の種類、被度、樹高を造成からの経過年数ごとに調査した。被度は、調査対象樹種の区域に

対する被覆率 29）を Braun-Blanquet の優先度階級２）により判別し、優先度階級ごとに示さ

れた被度範囲の中央値（表－９）を用いて樹種ごと、経過年数ごとに算定した。また、樹高

は区域内に同じ侵入木本類が複数個体ある場合は最も高いものを測定し、区域の代表値と

した。 
表－９ Braun-Blanquet の優先度階級 
 
 
 
 
 
 

（３）結果及び考察 
北海老地区では、ヤシャブシ（カバノキ科）、ヤマハギ、エニシダ、ハリエンジュ、フジ

（以上、マメ科）、イヌコリヤナギ（ヤナギ科）の６種が確認された。出現率は、ヤマハギ

が 26％で最も高く、次いでヤシャブシが４％であった。他の４種の出現率は低く、単発的

に散見された程度だった。ヤマハギの出現率は３年目が 58％と最も高く、５年目には 20％
まで低下した（表－10）。経過年数による被度の推移でも、ヤマハギは３年目が最も高く、

５年目までに低下した（図－26）。山田浜地区では、ヤシャブシ、ヤマハンノキ（以上、カ

バノキ科）、ヤマハギ、イタチハギ、ハリエンジュ、フジ（以上、マメ科）、イヌコリヤナギ、

コリヤナギ（以上、ヤナギ科）、ノリウツギ（ユキノシタ科）の９種が確認された。出現率

優先度階級 被度範囲 階級ごとの被度中央値

5 75～100％ 87
4 50～75％ 62
3 25～50％ 37
2 5～25％ 15
1 1～5％ 3
＋ 1％以下 1



は、ヤシャブシが 52％と高く、次いでヤマハギが 34％であった。他の７種の出現率は４％

以下だった（表－11）。経過年数による被度の推移では、ヤシャブシは５年目まで拡大傾向

が認められ、ヤマハギは４年目の被度が最も高く５年目は低下していた。また、ヤシャブシ、

ヤマハギ以外の７種の被度は調査期間を通じてわずかだった（図－27）。被度の拡大が見ら

れた山田浜地区のヤシャブシの樹高は年数を追うごとに大きくなり、５年目には３ｍに達

していた（図－28）。 
 
表－10 侵入木本類の出現率（北海老地区） 

 
 
 
 
 
 
 
表－11 侵入木本類の出現率（山田浜地区） 

  
 
 
 
 
 
 
 
 
 
 
 
 
 
図－26 経過年数ごとの侵入木本類の被度の推移（北海老地区） 

 
 
 
 
 
 
 
 
 

経過年数 調査区域数 ヤマハギ ヤシャブシ エニシダ ハリエンジュ イヌコリヤナギ フジ

1 61 0% 0% 0% 5% 0% 0%

2 26 39% 19% 8% 0% 0% 0%

3 33 58% 3% 0% 0% 0% 0%

4 36 50% 11% 0% 0% 3% 0%

5 92 20% 1% 0% 0% 1% 2%

計 248 26% 4% 1% 1% 1% 1%

経過年数 調査区域数 ヤシャブシ ヤマハギ コリヤナギ イヌコリヤナギ イタチハギ ヤマハンノキ ノリウツギ ハリエンジュ フジ

1 11 0% 18% 0% 0% 0% 0% 0% 0% 0%

2 40 38% 38% 10% 8% 0% 3% 0% 0% 0%

3 16 56% 31% 6% 6% 0% 0% 0% 0% 0%

4 39 51% 67% 3% 3% 0% 0% 3% 3% 3%

5 40 80% 5% 0% 0% 5% 0% 0% 0% 0%

計 146 52% 34% 4% 3% 1% 1% 1% 1% 1%



図－27 経過年数ごとの侵入木本類の被度の推移（山田浜地区） 
 
 
 
 
 
 
 
 
 
 
 

図－28 経過年数ごとのヤシャブシの樹高（山田浜地区） 
      ※エラーバー：標準誤差 
 
造成地に侵入する木本類は、周辺環境から飛来もしくは生育基盤資材に混入した種子由

来と考えられるため、周辺に生育する木本類や盛土資材の搬入先等の違いにより種類や出

現頻度が異なることが予想される。しかし、北海老地区、山田浜地区双方で出現率と被度が

相対的に高かった樹種はヤマハギとヤシャブシで、他の樹種は広い造成地の中で散見され

るに止まり、経過年数による拡大は見られなかった。このことから、造成から５年目までの

造成地の環境は木本類の侵入に厳しく、良好に生育する樹種はヤマハギ、ヤシャブシ等の数

種に限られることが窺われた。ヤマハギ、ヤシャブシは、ともに根に根粒菌を着生し痩地で

もよく生育することから荒廃地復旧にも用いられており 27）、造成から年数が少なく未熟土

に分類される生育基盤５）でも定着し、被度を拡げたと考えられた。このうち、ヤマハギは３

年ないし４年目までは出現率、被度が拡大したが、５年目までに縮小した。これは、ヤマハ

ギが低木であるため、植栽木のマツの成長に伴い、林縁以外では樹冠下に入って被圧される

ことが要因として考えられた。対して、ヤシャブシは山田浜地区では多くの箇所で侵入が確

認され５年目には３ｍを超え、多くの植栽クロマツを上回った。ヤシャブシは樹高６～７ｍ

の小高木であるため海岸防災林樹種としてマツを代替するとは考えられないが、ヤシャブ

シの生育に伴い造成地の土質が改善され、植栽マツや今後侵入してくる木本類の成長に良

い影響がある可能性は考えられる。このため現在、ヤシャブシが植栽マツよりも高く成長し

マツを被圧する懸念があっても一律に除去するのではなく、ヤシャブシが侵入した造成地

の環境の変化を植栽マツの成長と共に注目していくことも必要と考えられた。 
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